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Preface 

The purpose of this document is to provide the user with information about the 
import, export, configuration, and function of the IHSProduction. The IHSProduction 
has a package name of BADE and allows for the transportation of messages between 
the EDR and RPMS systems. Included with the production is a portal for monitoring 
and managing the production. 
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1.0 Introduction 
For over a decade, hospitals and health centers of the Indian Health Service (IHS) and 
numerous tribal health programs have utilized an information system called the 
Resource and Patient Management System (RPMS). The RPMS is a highly integrated 
system consisting of some fifty health care and administrative applications. Virtually 
all of these applications directly interact with one or more, and sometimes many, of 
the other RPMS applications. 

During this same period, IHS and tribal dental programs have made use of the RPMS 
Dental Data System (DDS) as their primary system for maintaining a history of 
individual patient services; contributing dental data to the RPMS electronic clinical 
record; producing provider and department workload data; and contributing statistical 
data to the national data center located in Albuquerque, New Mexico. At many sites, 
data captured in the DDS has also been utilized in the RPMS Third Party Billing 
System. 

With the replacement of the RPMS Dental Data System with an Electronic Dental 
Record (EDR), it is required that RPMS applications interact with the EDR to meet 
the needs of both the Dental Department and the local health program as a whole. 

The IHSProduction for the Ensemble Interface Engine (EIE) provides transportation 
of messages between the RPMS system and the EDR system. It accepts DFT_P03 
messages from the EDR system and delivers them to the RPMS system. It accepts 
MFN_M02, ADT_A31 and ADT_A28 messages from the RPMS system and delivers 
them to the EDR system. 

If an error occurs in receiving a valid EDR or RPMS HL7 message, if there is a 
connection issue between EIE and either system, or if any other error occurs, an alert 
is sent from the EIE to the appropriate administrators. 
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2.0 IHSProduction Import 
This section describes the process of importing the IHSProduction into Ensemble 
Studio from an XML document. 

2.1 Open Ensemble Studio 
• In a Windows environment, right-click the Ensemble Cube in the lower right 

corner and click Studio. Type your login ID and password. 

 

Figure 2-1: Opening Ensemble Studio 
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2.2 Select the proper namespace 
The namespace should be ENSRPMS. 

1. On the File menu, click Change NameSpace. 

 
Figure 2-2: Change Namespace menu option 
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2. In the Namespace list, click ENSRPMS. 

 

Figure 2-3: Selecting the ENSRPMS namespace 
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2.3 Import the IHSProduction 
1. On the Tools menu, click Import Local. 

 
Figure 2-4: Import Local menu option 
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2. Select the file named EDR_ENSRPMS.xml on your network or local machine and 
click Open. 

3. In the Import dialog box, ensure that all items in the list are selected and that 
both the Add Imported Items to Project and Compile Imported Items options 
are selected. 

 
Figure 2-5: Import dialog box 

4. Click OK. 

When the system finishes compiling, “Compilation finished successfully in…” is 
displayed in the Result pane. 

2.4 Select the system namespace 
1. On the File menu, click Change Namespace. 
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Figure 2-6: Change Namespace menu option 
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2. In the Namespace list, click %SYS. 

 
Figure 2-7: Selecting the %SYS namespace 
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2.5 Import the EDR system items 
1. On the Tools menu, click Import Local. 

 
Figure 2-8: Import Local menu option 
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2. On your network or local machine, select the EDR_SYS.xml file and click Open. 

3. In the Import dialog box, ensure that all items within the list are selected and that 
both the Add Imported items to Project and Compile Imported Items options 
are selected. 

 
Figure 2-9: Import dialog box 

4. Click OK. 

When the system finishes compiling, “Compilation finished successfully in…” is 
displayed in the Result pane. 
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3.0 EDR Installation Script 

3.1 Open a Terminal window 
1. In a Windows environment, right-click the Ensemble Cube in the lower right 

corner and click Terminal. Type your login ID and password. 

 
Figure 3-1: Logging on  
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2. At the “DEV” prompt, type zn “ensrpms” to change to the ENSRPMS 
namespace. 

 
Figure 3-2: Changing to the ENSRPMS namespace 
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3.2 Run the Installation Script 
• At the “ENSRPMS” prompt, type do ##class(BADE.Install).Installation(). 

 
Figure 3-3: Running the installation script 
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4.0 IHSProduction Configuration 
When the production is installed, the settings listed in Table 5-1 must be configured 
before the production can be run. 

NOTE: The settings listed in Table 5-1 are the only settings that 
should be changed. All other settings are configured 
correctly and should not be changed. 

Table 5-1: Settings that must be configured before IHSProduction can be run 

Business Host Host Type Setting 
RPMSInbound Business service ReceivingFacilityName 
RPMSInbound Business service MaxNmbrMsgs 
RPMSInbound Business service Throttle 
 Business service IP Address 
EDRInbound Business service Port 
RPMSOutbound Business operation SiteID 
RPMSOutbound Business operation LLink 
BadMessages Business operation FilePath 
EDROutbound Business operation IPAddress 
EDROutbound Business operation Port 
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4.1 Open the Ensemble Management Portal 
To open the Ensemble Management Portal, do one of the following: 

• In Ensemble Studio, click Ensemble Management on the Utilities menu. 

 
Figure 4-1: Ensemble Management menu option 
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• In the System Management Portal, click Ensemble Management Portal under 
System Administration. 

 
Figure 5-2: Selecting Ensemble Management Portal in the System Management Portal 
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4.2 Change the namespace to ENSRPMS 
The namespace should be ENSRPMS. 

• In the Namespace list, click ENSRPMS. 

 
Figure 5-3: Selecting the ENSRPMS namespace 
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4.3 Open the IHSProduction configuration page 
1. In the menu on the left side of the page, click Productions. 

 
Figure 5-4: Productions option 
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2. In the BADE.IHSProduction row, click Configure. 

 
Figure 5-5: Selecting the Configure option for BADE.IHSProduction 
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4.4 BADE.IHSProduction Settings 

 
Figure 5-6: BADE.IHSProduction configuration screen 

NOTE: Table 5-2 is provided for information only. The default 
settings on the BADE.IHSProduction configuration 
screen should not be changed. 

Table 5-2: BADE.IHSProduction settings 

Setting Value Comments 
Name BADE.IHSProduction The package name (BADE) and the 

production name (IHSProduction) 
separated by a period. 
 
(This setting should not be changed.) 

Description This production transports 
messages between the 
DENTRIX system and the 
RPMS system. 

 
 
(This setting should not be changed.) 

Actor Pool Size 2 The number of Actor jobs available to 
execute Business Process (BP) 
instances. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Testing Enabled Unchecked The Testing Service is not enabled for 

this production. 
 
(This setting should not be changed.) 

Log Unassigned 
Trace Events 

Checked Trace events that do not belong to any 
configuration item are logged. 
 
(This setting should not be changed.) 

ShutdownTimeout 120 The amount of time required for a click 
on Stop Production to succeed. 
 
(This setting should not be changed.) 

UpdateTimeout 10 The amount of time required for 
production updates to succeed. 
 
(This setting should not be changed.) 
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4.5 Business Services 

4.5.1 RPMSInbound Settings 

 
Figure 5-7: RPMSInbound configuration screen 

NOTE: In Table 5-3, only the settings shown in italics (Receiving 
Facility Name, MaxNmbrMsgs, and Throttle) should be 
changed. 
 
All other settings are configured correctly. The default 
values should not be changed. 
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Table 5-3: RPMSInbound settings 

Setting Value Comments 
Name RPMSInbound (This setting should not be changed.) 

Comment Retrieve messages 
from the HLA and HLB 
globals 

 
(This setting should not be changed.) 

Schedule <blank> The Start/Stop schedule associated with 
this item. This setting should not be 
changed. 
 
(This setting should not be changed.) 

Category EDR A grouping for pieces of a production that 
can be used to filter views for a production. 
 
(This setting should not be changed.) 

Class BADE.Services.RPMS (This setting should not be changed.) 

Description A business service that 
receives messages 
from the RPMS system 
via the HLOGlobal 
Inbound Adapter 

 
 
 
(This setting should not be changed.) 

Enabled Checked This item is enabled when this production is 
started. 
 
(This setting should not be changed.) 

Foreground Unchecked This item is not run in a foreground process. 
 
(This setting should not be changed.) 

Log Trace Events Checked Logging of trace events is enabled for 
troubleshooting purposes. A global variable 
is used in conjunction with this setting to 
enable trace events for this production. 
 
(This setting should not be changed.) 

Inactivity Timeout 0 Number of seconds that can elapse without 
activity before this item is marked inactive. A 
setting of 0 disables the inactivity timeout 
function. 
 
(This setting should not be changed.) 

Pool Size 1 Number of system jobs that must be 
allocated to run this business service. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Adapter Class BADE.Adapters. 

HLOGlobalInbound 
Name of the Adapter class declared in the 
Business class for this item. 
 
(This setting should not be changed.) 

Target Config 
Names 

BADE. 
RPMSMessageRouting 

The Business host where messages are 
sent. 
 
(This setting should not be changed.) 

Search Table 
Class 

EnsLib.HL7. 
SearchTable  

The set of searchable properties associated 
with each HL7 message processed. 
 
(This setting should not be changed.) 

Local Facility 
Application 

ISC:EnsembleHL7 The LocalFacility:LocalApplication codes 
representing this (receiving) facility and 
application, separated by a colon. Used as 
SendingFacility and SendApplication in 
reply ACK message headers. 
 
(This setting should not be changed.) 

Framing Flexible The HL7 inbound message framing 
protocol. Flexible = Determine framing style 
from the content of received data. 
 
(This setting should not be changed.) 

Ack mode Never Controls ACK handling. Never = do not 
send back any ACK. 
 
(This setting should not be changed.) 

Use Ack Commit 
Codes 

False Use legacy-mode ‘Ax’ codes. 
 
(This setting should not be changed.) 

IgnoreInboundAck False Ignore inbound ACK messages to avoid 
ACK feedback loop. This setting has no 
effect on this inbound adapter/service since 
it does not receive or send ACK messages 
to RPMS. 
 
(This setting should not be changed.) 

AddNackERR False Do not add an ERR error code segment 
when generating NACK messages. (Not 
used for this service since it does not send 
NACK/ACK messages.) 
 
(This setting should not be changed.) 

BatchHandling Single-Session Batch  RPMS is not sending batched messages. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Message Schema 
Category 

BADE.RPMS Category to apply to incoming message 
types to produce a complete DocType 
specification. Combines with document type 
name (MSH:9) to produce a MessageType 
specification, which is used to look up a 
MessageStructure/DocType in the 
MessageTypes section of the given HL7 
schema category. 
 
(This setting should not be changed.) 

DefCharEncoding Latin1  The default character encoding used when 
reading or writing HL7 messages. 
 
(This setting should not be changed.) 

Alert Grace Period 5 When Alert On Error is set to True, refrain 
from alerting if the error is not from 
ProcessInput() and the service succeeds 
again within this number of seconds. 
 
(This setting should not be changed.) 

Alert On Error True Send an alert message whenever an error 
occurs. 
 
(This setting should not be changed.) 

Archive IO False  The adapter does not log each input and 
output communication with the external 
system to the Ensemble I/O archive. 
 
(This setting should not be changed.) 

Receiving Facility 
Name 

DENTRIX Name of receiving facility on which to filter 
HL7 messages within the 
HLOGlobalInbound adapter. 

MaxNmbrMsgs 50 Maximum number of messages processed 
in each polling interval. This value may 
need to be adjusted depending on the 
number of messages received and/or 
processed and the processing power of the 
server running the EIE. In most cases, this 
setting will only affect the initial patient 
upload when large numbers of records may 
be processed. 
 
This value can also be modified using the 
EIE Management Portal. 
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Setting Value Comments 
Throttle 1000 The amount of time to delay after 

processing each message; used to manage 
throughput. 1000 = 1 second of delay 
between each message processed. 
 
This value can also be modified using the 
EIE Management Portal. 

Site ID <Installation site ID> Numeric DUZ(2) value 

Call Interval 5 Minimum interval between invocations of 
the adapter by the Ensemble framework. 
For adapters that poll for external events, 
this is the polling interval. This value can 
also be modified using the EIE Management 
Portal. 
 
(This setting should not be changed.) 
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4.5.2 EDRInbound Settings 

 
Figure 5-8: EDRInbound configuration screen 

NOTE: In Table 5-4, only the setting shown in italics (IP Address 
and  Port) should be changed. 
 
All other settings are configured correctly. The default 
values should not be changed. 

Table 5-4: EDRInbound settings 

Setting Value Comments 
Name EDRInbound (This setting should not be changed.) 

Comment Accept messages from 
the EDR system via 
TCP/IP 

 
(This setting should not be changed.) 



Electronic Dental Interface (EDRI) Version 1.0 

Installation Guide & Release Notes IHSProduction Configuration 
February 2010 

28 

Setting Value Comments 
Schedule <blank> The Start/Stop schedule associated with 

this item. 
 
(This setting should not be changed.) 

Category EDR A grouping for pieces of a production that 
can be used to filter views for a 
production. 
 
(This setting should not be changed.) 

Class EnsLib.HL7.Service. 
TCPService 

 
(This setting should not be changed.) 

Description <blank> (This setting should not be changed.) 

Enabled Checked This item is enabled when this production 
is started. 
 
(This setting should not be changed.) 

Foreground Unchecked This item is not run in a foreground 
process. 
 
(This setting should not be changed.) 

Log Trace Events Checked Logging of trace events is enabled for 
troubleshooting purposes. A global 
variable is used in conjunction with this 
setting to enable trace events for this 
production. 
 
(This setting should not be changed.) 

Inactivity Timeout 0 Number of seconds that can elapse 
without activity before this item is marked 
inactive. A setting of 0 disables the 
inactivity timeout function. 
 
(This setting should not be changed.) 

Pool Size 1  Number of system jobs that must be 
allocated to run this business service. 
 
(This setting should not be changed.) 

Adapter Class EnsLib.HL7.Adapter. 
TCPInboundAdapter 

Name of the Adapter class declared in the 
Business class for this item. 
 
(This setting should not be changed.) 

Target Config 
Names 

BADE. 
EDRMessageRouting 

The business host where messages are 
sent. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Search Table 
Class 

EnsLib.HL7.SearchTable  The set of searchable properties 
associated with each HL7 message 
processed. 
 
(This setting should not be changed.) 

Local Facility 
Application 

ISC:EnsembleHL7 The LocalFacility:LocalApplication codes 
representing this (receiving) facility and 
application, separated by a colon. Used 
as SendingFacility and SendApplication in 
reply ACK message headers. 
 
(This setting should not be changed.) 

Framing Flexible The HL7 inbound message framing 
protocol. Flexible = Determine framing 
style from the content of received data. 
 
(This setting should not be changed.) 

Ack mode Immediate Controls ACK handling. Immediate = 
Send back (commit) ACK reply message 
immediately upon receipt of the inbound 
message. 
 
(This setting should not be changed.) 

Use Ack Commit 
Codes 

True If HL7 message VersionID is 2.3 or 
higher, use the “enhanced-mode” ACK 
“Commit” codes (“Cx”) in MSA:1 
(“AcknowledgementCode”). 
 
(This setting should not be changed.) 

IgnoreInboundAck True Set to True to avoid ACK feedback loop. 
 
(This setting should not be changed.) 

AddNackERR True If a Nack message is sent (ACK with an 
error), the ERR code segment is added. 
 
(This setting should not be changed.) 

BatchHandling Single-Session Batch  EDR is not sending batched HL7 
messages. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Message Schema 
Category 

BADE.EDR Category to apply to incoming message 
types to produce a complete DocType 
specification. Combines with document 
type name (MSH:9) to produce a 
MessagType specification, which is used 
to look up a MessageStructure/DocType 
in the MessageTypes section of the given 
HL7 schema category. 
 
(This setting should not be changed.) 

DefCharEncoding Latin1 The default character encoding used 
when reading or writing HL7 messages. 
 
(This setting should not be changed.) 

Alert Grace Period 5 When Alert On Error is set to True, 
refrain from alerting if the error is not from 
ProcessInput() and the service succeeds 
again within this number of seconds. 
 
(This setting should not be changed.) 

Alert On Error True Send an alert message whenever an error 
occurs. 
 
(This setting should not be changed.) 

Archive IO False  The adapter does not log each input and 
output communication with the external 
system to the Ensemble I/O archive. 
 
(This setting should not be changed.) 

Job Per 
Connection 

False  A new job is not spawned to handle each 
incoming TCP connection. Multiple 
connections are not handled 
simultaneously. 
 
(This setting should not be changed.) 

Allowed IP 
Addresses 

IP Address of Dentrix 
Server 

Must be set to the IP address of 
DENTRIX dental server. 

QSize 0  Number of incoming connections for the 
operating system to hold open on behalf 
of EDR. Set to 0 if only one connection at 
a time is expected. Set to a large number 
if many clients will be connecting rapidly. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Call Interval 5 Minimum interval between invocations of 

the adapter by the Ensemble framework. 
For adapters that poll for external events, 
this is the polling interval. 
 
(This setting should not be changed.) 

Port 5028 TCP port that listens for and accepts 
connections.This must match the Dentrix 
Servers outbound message port. The 
Default is 5028. 

Stay Connected -1 -1 = never disconnect. 
 
(This setting should not be changed. Note 
that the setting is negative 1.) 

Read Timeout 5  Number of seconds to wait for each 
successive incoming TCP read following 
receipt of initial data from remote TCP 
port. 
 
(This setting should not be changed.) 

SSL Config <blank> (This setting should not be changed.) 
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4.6 Business Processes 

4.6.1 BADE.EDRMessageRouting Settings 

 
Figure 5-9: BADE.EDRMessageRouting configuration screen 

NOTE: Table 5-5 is provided for information only. The default 
settings on the BADE.EDRMessageRouting 
configuration screen should not be changed. 

Table 5-5: BADE.EDRMessageRouting settings 

Setting Value Comments 
Name BADE.EDRMessageRouting (This setting should not be changed.) 

Comment Routes messages received 
from the EDR system.  

 
(This setting should not be changed.) 

Schedule <blank> The Start/Stop schedule associated 
with this item. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Category EDR A grouping for pieces of a production 

that can be used to filter views for a 
production. 
 
(This setting should not be changed.) 

Class EnsLib.HL7.MessageRouter. 
RoutingEngine 

 
(This setting should not be changed.) 

Description <blank> (This setting should not be changed.) 

Enabled Checked This item is enabled when this 
production is started. 
 
(This setting should not be changed.) 

Foreground Unchecked Do not run this item in a foreground 
process. 
 
(This setting should not be changed.) 

Log Trace Events Checked Logging of trace events is enabled for 
troubleshooting purposes. A global 
variable is used in conjunction with this 
setting to enable trace events for this 
production. 
 
(This setting should not be changed.) 

Inactivity Timeout 0 Number of seconds that can elapse 
without activity before this item is 
marked inactive. A setting of 0 disables 
the inactivity timeout function. 
 
(This setting should not be changed.) 

Pool Size 1 Number of system jobs that must be 
allocated to run this business service. 
 
(This setting should not be changed.) 

Local Facility 
Application 

ISC:EnsembleHL7 The LocalFacility:LocalApplication 
codes representing this (receiving) 
facility and application, separated by a 
colon. Used as SendingFacility and 
SendApplication in reply ACK message 
headers. 
 
(This setting should not be changed.) 

Ack Type <blank> Determines the ACK type (e.g., AA vs. 
CA) if constructing an ACK or NACK 
reply message locally. 
 
(This setting should not be changed.) 
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Setting Value Comments 
NackCode <blank> Determines the NACK code type (e.g., 

AE vs. AR) if constructing a NACK 
reply message locally to report an 
error. 
 
(This setting should not be changed.) 

AddNackERR False Do not add an ERR code segment to 
Nack (ACK with an error) messages. 
 
(This setting should not be changed.) 

Validation dm-z  d = require a DocType; m = do not 
tolerate BuildMap errors; -z = do not 
tolerate unrecognized trailing Z-
segments. 
 
(This setting should not be changed.) 

Business Rule 
Name 

BADE.EDRMessageRouting  
(This setting should not be changed.) 

Alert on Bad 
Message 

True Send an alert if validation blocks a 
message. 
 
(This setting should not be changed.) 

Bad Message 
Handler 

BadMessages Name of host that handles messages 
blocked by validation. 
 
(This setting should not be changed.) 

Response From <blank> No reply will be requested from any 
target. A message is ACKed when it is 
received from the DENTRIX system. 
 
(This setting should not be changed.) 

Response Target 
Config Names 

<blank> Names a destination or destinations, in 
addition to the caller, to which 
responses are forwarded. Left blank 
because no ACKs are being received 
or created. 
 
(This setting should not be changed.) 

Response 
Timeout 

-1  This setting has no effect if 
ResponseFrom is empty. 
 
(This setting should not be changed. 
Note that the setting is negative 1.) 

ForceSyncSend False  Do not make synchronous calls for 
“send” actions. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Alert On Error True Send an alert message whenever an 

error occurs. 
 
(This setting should not be changed.) 

4.6.2 BADE.RPMSMessageRouting Settings 

 
Figure 5-10: BADE.RPMSMessageRouting configuration screen 

NOTE: Table 5-6 is provided for information only. The default 
settings on the BADE.RPMSMessageRouting 
configuration screen should not be changed. 

Table 5-6: BADE.RPMSMessageRouting settings 

Setting Value Comments 
Name BADE. 

RPMSMessageRouting 
 
(This setting should not be changed.) 

Comment Routes messages received 
from the RPMS system 

 
(This setting should not be changed.) 
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Setting Value Comments 
Schedule <blank> The Start/Stop schedule associated with 

this item. 
 
(This setting should not be changed.) 

Category EDR A grouping for pieces of a production 
that can be used to filter views for a 
production. 
 
(This setting should not be changed.) 

Class EnsLib.HL7.MsgRouter. 
RoutingEngine 

 
(This setting should not be changed.) 

Description <blank> (This setting should not be changed.) 

Enabled Checked This item is enabled when this 
production is started. 
 
(This setting should not be changed.) 

Foreground Unchecked Do not run this item in a foreground 
process. 
 
(This setting should not be changed.) 

Log Trace Events Checked Logging of trace events is enabled for 
troubleshooting purposes. A global 
variable is used in conjunction with this 
setting to enable trace events for this 
production. 
 
(This setting should not be changed.) 

Inactivity 
Timeout 

0 Number of seconds that can elapse 
without activity before this item is 
marked inactive. A setting of 0 disables 
the inactivity timeout function. 
 
(This setting should not be changed.) 

Pool Size 1  Number of system jobs that must be 
allocated to run this business service. 
 
(This setting should not be changed.) 

Local Facility 
Application 

ISC:EnsembleHL7 The LocalFacility:LocalApplication 
codes representing this (receiving) 
facility and application, separated by a 
colon. Used as SendingFacility and 
SendApplication in reply ACK message 
headers. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Ack Type <blank>  Determines the ACK type (e.g., AA vs. 

CA) if constructing an ACK or NACK 
reply message locally. 
 
(This setting should not be changed.) 

NackCode <blank>  Determines the NACK code type (e.g., 
AE vs. AR) if constructing a NACK reply 
message locally to report an error. 
 
(This setting should not be changed.) 

AddNackErr False Do not add an ERR code segment to 
Nack (ACK with an error) messages. 
 
(This setting should not be changed.) 

Validation dm-z  d = require a DocType; m = do not 
tolerate BuildMap errors; -z = do not 
tolerate unrecognized trailing Z-
segments. 
 
(This setting should not be changed.) 

Business Rule 
Name 

BADE. 
RPMSMessageRouting 

 
(This setting should not be changed.) 

Alert on Bad 
Message 

True Send an alert if validation blocks a 
message. 
 
(This setting should not be changed.) 

Bad Message 
Handler 

BadMessages Name of host that handles messages 
blocked by validation. 
 
(This setting should not be changed.) 

Response From EDROutbound The target an ACK response should be 
forwarded to. 
 
(This setting should not be changed.) 

Response Target 
Config Names 

RPMSOutbound The destination or destinations, in 
addition to the caller, to which 
responses are forwarded. 
 
(This setting should not be changed.) 

Response 
TimeOut 

-1  This setting has no effect if 
ResponseFrom is empty. 
 
(This setting should not be changed. 
Note that the setting is negative 1.) 

ForceSyncSend False  Do not make synchronous calls for 
“send” actions. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Alert On Error True Send an alert message whenever an 

error occurs. 
 
(This setting should not be changed.) 

4.6.3 ENS.Alert Settings 

 
Figure 5-11: ENS.Alert configuration screen 

NOTE: Table 5-7 is provided for information only. The default 
settings on the ENS.Alert configuration screen should not 
be changed. 

Table 5-7: ENS.Alert settings 

Setting Value Comments 
Name ENS.Alert (This setting should not be changed.) 

Comment <blank> (This setting should not be changed.) 

Schedule <blank> The Start/Stop schedule associated with 
this item. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Category EDR A grouping for pieces of a production 

that can be used to filter views for a 
production. 
 
(This setting should not be changed.) 

Class BADE.Processes. 
AlertProcess 

 
(This setting should not be changed.) 

Description <blank> (This setting should not be changed.) 

Enabled Checked This item is enabled when this 
production is started. 
 
(This setting should not be changed.) 

Foreground Unchecked Do not run this item in a foreground 
process. 
 
(This setting should not be changed.) 

Log Trace Events Checked Logging of trace events is enabled for 
troubleshooting purposes. A global 
variable is used in conjunction with this 
setting to enable trace events for this 
production. 
 
(This setting should not be changed.) 

Inactivity 
Timeout 

0 Number of seconds that can elapse 
without activity before this item is 
marked inactive. A setting of 0 disables 
the inactivity timeout function. 
 
(This setting should not be changed.) 

Pool Size 0 Number of system jobs that must be 
allocated to run this business service. 
 
(This setting should not be changed.) 

Alert On Error False Do not send an alert message when an 
error occurs. 
 
(This setting should not be changed.) 
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4.7 Business Operations 

4.7.1 RPMSOutbound Settings 

 
Figure 5-12: RPMSOutbound configuration screen 

NOTE: In Table 5-8, only the setting shown in italics (SiteID and 
LLink) should be changed. 
 
All other settings are configured correctly. The default 
values should not be changed. 

Table 5-8: RPMSOutbound settings 

Setting Value Comments 
Name RPMSOutbound (This setting should not be changed.) 

Comment Place the HL7 message 
into the HLA and HLB 
globals 

 
 
(This setting should not be changed.) 

Schedule <blank> The Start/Stop schedule associated with 
this item. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Category EDR A grouping for pieces of a production 

that can be used to filter views for a 
production. 
 
(This setting should not be changed.) 

Class BADE.Operations. 
RPMS 

 
(This setting should not be changed.) 

Description The outbound operation 
that communicates with the 
RPMS system 

 
 
(This setting should not be changed.) 

Enabled Checked This item is enabled when this 
production is started. 
 
(This setting should not be changed.) 

Foreground Unchecked Do not run this item in a foreground 
process. 
 
(This setting should not be changed.) 

Log Trace Events Checked Logging of trace events is enabled for 
troubleshooting purposes. A global 
variable is used in conjunction with this 
setting to enable trace events for this 
production. 
 
(This setting should not be changed.) 

Inactivity Timeout 0 Number of seconds that can elapse 
without activity before this item is 
marked inactive. A setting of 0 disables 
the inactivity timeout function. 
 
(This setting should not be changed.) 

Pool Size 1  Number of system jobs that must be 
allocated to run this business service. 
 
(This setting should not be changed.) 

Adapter Class BADE.Adapters. 
HLOGlobal Outbound 

The name of the Adapter class declared 
in the Business class for this item. 
 
(This setting should not be changed.) 

Separators |^~\& The string of separator characters to use 
in encoding outbound messages. The 
order is FS, CS, RS, ESC, SS. 
 
(This setting should not be changed.) 

Search Table 
Class 

<blank> No search table is being used. 
 
(This setting should not be changed.) 
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Setting Value Comments 
DefCharEncoding Latin1  The default character encoding used 

when reading or writing HL7 messages. 
 
(This setting should not be changed.) 

Alert Retry Grace 
Period 

5 When Alert On Error is set to True, 
refrain from alerting if the error is not 
from ProcessInput() and the service 
succeeds again within this number of 
seconds. 
 
(This setting should not be changed.) 

Retry Interval 5 How frequently to retry access to the 
output system. 
 
(This setting should not be changed.) 

Failure Timeout 25 How long to keep retrying before giving 
up and returning an error code. 
 
(This setting should not be changed.) 

Alert On Error True Send an alert message whenever an 
error occurs here. 
 
(This setting should not be changed.) 

Archive IO False  The adapter does not log each input and 
output communication with the external 
system to the Ensemble I/O archive. 
 
(This setting should not be changed.) 

Framing MLLP (HL7 message 
outbound protocol) 

Minimal Lower Level Protocol. Frame 
each HL7 message with ASCII(11) prefix 
and ASCII(28,13) suffix. 
 
(This setting should not be changed.) 

SiteID Dental Facility number. Either Numeric site ID 
for the facility or Name. This field is used 
to append the IEN for use with the HLO 
message lookup. It generates the NAME 
field of the HLO Message file .The 
Default is Dental 

LLink RPMS-DEN Logical link between the two systems. 
This value should match the name used 
in the HLO Application Registry file. The 
default is RPMS-DEN 
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4.7.2 EDROutbound Settings 

 
Figure 5-13: EDROutbound configuration screen 

NOTE: In Table 5-9, only the settings shown in italics (IPAddress 
and Port) should be changed. 
 
All other settings are configured correctly. The default 
values should not be changed. 

Table 5-9: EDROutbound settings 

Setting Value Comments 
Name EDROutbound (This setting should not be 

changed.) 

Comment Sends the HL7 
messages to the EDR 
system via TCP/IP 

 
 
(This setting should not be 
changed.) 
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Setting Value Comments 
Schedule <blank> The Start/Stop schedule associated 

with this item. 
 
(This setting should not be 
changed.) 

Category EDR A grouping for pieces of a production 
that can be used to filter views for a 
production. 
 
(This setting should not be 
changed.) 

Class EnsLib.HL7.Operation. 
TCPOperation 

 
 
(This setting should not be 
changed.) 

Description Accepts HL7 Messages 
and forwards them to a 
remote IP address, 
reading a response 
HL7 Message object 
returned from the 
remote IP address if 
the GetReply setting is 
enabled. 

 
 
 
 
 
 
(This setting should not be 
changed.) 

Enabled Checked This item is enabled when this 
production is started. 
 
(This setting should not be 
changed.) 

Foreground Unchecked Do not run this item in a foreground 
process. 
 
(This setting should not be 
changed.) 

Log Trace Events Checked Logging of trace events is enabled 
for troubleshooting purposes. A 
global variable is used in conjunction 
with this setting to enable trace 
events for this production. 
 
(This setting should not be 
changed.) 
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Setting Value Comments 
Inactivity Timeout 0 Number of seconds that can elapse 

without activity before this item is 
marked inactive. A setting of 0 
disables the inactivity timeout 
function. 
 
(This setting should not be 
changed.) 

Pool Size 1  Number of system jobs that must be 
allocated to run this business 
service. 
 
(This setting should not be 
changed.) 

Adapter Class EnsLib.HL7.Adapter. 
TCPOutboundAdapter 

(This setting should not be 
changed.) 

ReplyCodeActions <blank> List of codes specifying actions to 
take on receipt of various types of 
ACK response messages. 
 
When left blank, DENTRIX default 
action is to send “AA” in the MSA:1 
field. 
 
(This setting should not be 
changed.) 

NoFailwhileDisconnected False Do not suspend counting seconds 
toward FailureTimeout when 
disconnected. 
 
(This setting should not be 
changed.) 

Separators |^~\& The string of separator characters to 
use in encoding outbound 
messages. The order is FS, CS, RS, 
ESC, SS. 
 
(This setting should not be 
changed.) 

Search Table Class <blank> No search table is being used. 
 
(This setting should not be 
changed.) 

DefCharEncoding Latin1  The default character encoding used 
when reading or writing HL7 
messages. 
 
(This setting should not be 
changed.) 
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Setting Value Comments 
Alert Retry Grace Period 5 When Alert On Error is set to True, 

refrain from alerting if the error is not 
from ProcessInput() and the service 
succeeds again within this number of 
seconds. 
 
(This setting should not be 
changed.) 

Retry Interval 5 How frequently to retry access to the 
output system. 
 
(This setting should not be 
changed.) 

Failure Timeout -1 How long to keep retrying before 
giving up and returning an error 
code. 
 
(This setting should not be changed. 
Note that the setting is negative 1.) 

Alert On Error True Send an alert message whenever an 
error occurs here. 

Archive IO False  The adapter does not log each input 
and output communication with the 
external system to the Ensemble I/O 
archive. 
 
(This setting should not be 
changed.) 

Framing MLLP  Minimal Lower Level Protocol. 
Frame each HL7 message with 
ASCII(11) prefix and ASCII(28,13) 
suffix. 
 
(This setting should not be 
changed.) 

IP Address 198.45.6.101 IP address of the Dentrix Server 

Port 5027 Port number for the Dentrix Server 
Inbound messages. The default 
setting is 5027 
 

Response Timeout 5 Number of seconds to wait for a 
response to begin arriving from the 
remote system after sending a 
request. 
 
(This setting should not be 
changed.) 
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Setting Value Comments 
Stay Connected -1 Never disconnect 

 
(This setting should not be changed. 
Note that the setting is negative 1.) 

Connect Timeout 5 Number of seconds to wait on each 
connection attempt. 
 
(This setting should not be 
changed.) 

Reconnect Retry 5 Number of retries before dropping 
the connection and trying to 
reconnect again. If set to 0, never 
disconnect. 
 
(This setting should not be 
changed.) 

Get Reply True Wait to read ACK or other reply 
message from socket before 
returning. 
 
(This setting should not be 
changed.) 

Read Timeout 5 Number of seconds to wait for each 
successive incoming TCP read, 
following receipt of initial data from 
remote TCP port. 
 
(This setting should not be 
changed.) 

SSL Config <blank> The name of an existing Secure 
Socket Layer/Transport Layer 
Security (SSL/TLS) system 
configuration set to use SSL/TLS, 
configured using the system portal’s 
Security Management page. May 
include a certificate password after a 
“|” character for inbound 
connections. 
 
Left blank because SSL is not being 
used. 
 
(This setting should not be 
changed.) 
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4.7.3 BadMessages Settings 

 
Figure 5-14: BadMessages configuration screen 

NOTE: In Table 5-10, only the setting shown in italics (FilePath) 
should be changed. 
 
All other settings are configured correctly. The default 
values should not be changed. 

Table 5-10: BadMessages settings 

Setting Value Comments 
Name BadMessages (This setting should not be changed.) 

Comment Write messages that 
erred to a file. 

(This setting should not be changed.) 

Schedule <blank> The Start/Stop schedule associated with 
this item. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Category EDR A grouping for pieces of a production 

that can be used to filter views for a 
production. 
 
(This setting should not be changed.) 

Class EnsLib.HL7.Operation. 
FileOperation 

(This setting should not be changed.) 

Description <blank> (This setting should not be changed.) 

Enabled Checked This item is enabled when this 
production is started. 
 
(This setting should not be changed.) 

Foreground Unchecked Do not run this item in a foreground 
process. 
 
(This setting should not be changed.) 

Log Trace Events Checked Logging of trace events is enabled for 
troubleshooting purposes. A global 
variable is used in conjunction with this 
setting to enable trace events for this 
production. 
 
(This setting should not be changed.) 

Inactivity Timeout 0 Number of seconds that can elapse 
without activity before this item is 
marked inactive. A setting of 0 disables 
the inactivity timeout function. 
 
(This setting should not be changed.) 

Pool Size 1  Number of system jobs that must be 
allocated to run this business service. 
 
(This setting should not be changed.) 

Adapter Class EnsLib.File. 
OutboundAdapter 

(This setting should not be changed.) 

File Name BadMessageFile Name of output file for bad messages. 
 
The default is blank. 

AutoBatchParentSegs False No batch messages. 
 
(This setting should not be changed.) 

Separators |^~\& The string of separator characters to use 
in encoding outbound messages. The 
order is FS, CS, RS, ESC, SS. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Search Table Class <blank> No search table being used. 

 
(This setting should not be changed.) 

DefCharEncoding Latin1  The default character encoding used 
when reading or writing HL7 messages. 
 
(This setting should not be changed.) 

Alert Retry Grace 
Period 

5 When Alert On Error is set to True, 
refrain from alerting if the error is not 
from ProcessInput() and the service 
succeeds again within this number of 
seconds. 
 
(This setting should not be changed.) 

Retry Interval 5 How frequently to retry access to the 
output system. 
 
(This setting should not be changed.) 

Failure Timeout -1 How long to keep retrying before giving 
up and returning an error code. 
 
(This setting should not be changed.) 

Alert On Error True Send an Alert message whenever an 
error occurs here. 
 
(This setting should not be changed.) 

Archive IO False  The adapter does not log each input and 
output communication with the external 
system to the Ensemble I/O archive. 
 
(This setting should not be changed.) 

Framing AsciiLF  Frame each HL7 message with 
ASCII(10) (Linefeed) separating each 
message from the next. 
 
(This setting should not be changed.) 

File Path <path to server where 
EIE resides.> 

Path where bad messages can be stored 
for later review.  In Windows the default 
is CTEMP and in UNIX the default is  
/tmp 

Overwrite False Append the file. 
 
(This setting should not be changed.) 

Charset Default  Character set used to translate output to 
the file. 
 
(This setting should not be changed.) 
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Setting Value Comments 
Open Timeout 5 Number of seconds to wait on each 

attempt to open the output file. 
 
 
(This setting should not be changed.) 

4.7.4 EmailAlert Settings 

 
Figure 5-15: EmailAlert configuration screen  

NOTE: In Table 5-11, only the settings shown in italics (SMTP 
Server, Credentials, Recipient, and Cc) should be changed. 
 
All other settings are configured correctly. The default 
values should not be changed. 

Table 5-11: EmailAlert settings 

Setting Value Comments 
Name EmailAlert (This setting should not be 

changed.) 
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Setting Value Comments 
Comment <blank> Additional information 

pertaining to this business 
class. 
 
(This setting should not be 
changed.) 

Schedule <blank> The Start/Stop schedule 
associated with this item. 
 
(This setting should not be 
changed.) 

Category EDR A grouping for pieces of a 
production that can be used 
to filter views for a 
production. 
 
(This setting should not be 
changed.) 

Class EnsLib.Email.AlertOperation (This setting should not be 
changed.) 

Description Simple EMail Alert Operation. To 
handle Alert messages by sending 
an EMail, configure an Operation in 
your Production named Ens.Alert 
using this class. Ensemble sends 
all AlertRequest messages to 
whatever Production Item is named 
Ens.Alert. (If there is no item 
named Ens.Alert then all 
AlertRequest messages are merely 
recorded in the Ensemble Event 
Log.) 

 
 
 
 
 
 
 
 
 
 
(This setting should not be 
changed.) 

Enabled Checked This item is enabled when 
this production is started. 
 
(This setting should not be 
changed.) 

Foreground Unchecked Do not run this item in a 
foreground process. 
 
(This setting should not be 
changed.) 
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Setting Value Comments 
Log Trace Events Checked Logging of trace events is 

enabled for troubleshooting 
purposes. A global variable 
is used in conjunction with 
this setting to enable trace 
events for this production. 
 
(This setting should not be 
changed.) 

Inactivity Timeout 0 Number of seconds that can 
elapse without activity 
before this item is marked 
inactive. A setting of 0 
disables the inactivity 
timeout function. 
 
(This setting should not be 
changed.) 

Pool Size 1  Number of system jobs that 
must be allocated to run this 
business service. 
 
(This setting should not be 
changed.) 

Adapter Class EnsLib.File.OutboundAdapter (This setting should not be 
changed.) 

Alert Retry Grace 
Period 

5 When Alert On Error is set 
to True, refrain from alerting 
if the error is not from 
ProcessInput() and the 
service succeeds again 
within this number of 
seconds. 
 
(This setting should not be 
changed.) 

Retry Interval 5 How frequently to retry 
access to the output system. 
 
(This setting should not be 
changed.) 

Failure Timeout 25 How long to keep retrying 
before giving up and 
returning an error code. 
 
(This setting should not be 
changed.) 



Electronic Dental Interface (EDRI) Version 1.0 

Installation Guide & Release Notes IHSProduction Configuration 
February 2010 

54 

Setting Value Comments 
Alert On Error False Do not send an Alert 

message when an error 
occurs here. 
 
(This setting should not be 
changed.) 

Archive IO False  The adapter does not log 
each input and output 
communication with the 
external system to the 
Ensemble I/O archive. 
 
(This setting should not be 
changed.) 

SMTP Server SMTPRE.IHS.GOV IP address of SMTP server 
to send mail to. For HIS 
Direct Sites connected to the 
HIS.GOV Intranet, the 
default is 
SMTPRE.IHS.GOV 
 
Note: Timeouts for 
connecting and sending mail 
can be more than 10 
minutes. 

SMTP Port 25 The Port ID on the SMTP 
server to send mail to. 
 
(This setting should not be 
changed.) 

Credentials <ID> ID name of the credential set 
used to access the SMTP 
server.The default is blank 

Recipient <one or more e-mail addresses> E-mail address(es) of a 
recipient or list of recipients 
that will be added to the To: 
list of each e-mail message 
sent. This is automatically 
generated when e-mail 
addresses are entered using 
the EIE Management 
Portal.Multiuple addresses 
can be included. Addresses 
should be separated by 
commas. 
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Setting Value Comments 
CC <one or more e-mail addresses> E-mail address(es) of a 

recipient or list of recipients 
that will be added to the To: 
list of each e-mail message 
sent. This is automatically 
generated when e-mail 
addresses are entered using 
the EIE Management Portal. 
Multiuple addresses can be 
included. Addresses should 
be separated by commas. 

From EnsembleEDR@RPMS.WINDOWS The Site should be identified 
in the email address. 
 
Example: 
EnsembleEDR@MySiteNam
e.IHS.GOV 

mailto:EnsembleEDR@RPMS.WINDOWS�
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5.0 IHSProduction Export 
NOTE: Once your production is fully operational, each site should 

produce an export of their IHSProduction and save the file 
in a safe location. In the event that your site has a full 
system failure, you can recover all of your default operation 
settings by importing this saved file. You should make sure 
the file name contains the date and time stamp of the 
export. 

5.1 Open Ensemble Studio 
In a Windows environment, right-click the Ensemble Cube in the lower right corner 
and click Studio. Type your login ID and password. 

 

Figure 6-1: Opening Ensemble Studio 
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5.2 Select the Proper Namespace 
The namespace should be ENSRPMS. 

1. On the File menu, click Change Namespace. 

 
Figure 6-2: Change Namespace menu option 
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2. In the Namespace list, click ENSRPMS. 

 
Figure 6-3: Selecting the ENSRPMS namespace 
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5.3 Open the project 
Ensure that the EDR_ENSRPMS project is open. 

1. On the File menu, click Open Project. 

2. In the Open dialog box, select EDR_ENSRPMS, and click Open. 

 
Figure 6-4: Opening the EDR_ENSRPMS project 
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5.4 Export the IHSProduction 
1. On the Tools menu, click Export. 

 
Figure 6-5: Export menu option 
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2. In the Export dialog box, ensure that the Export current Project box is selected. 

3. Click Export to Local File. Type the path and file name in the text box, and then 
click OK.. 

 
Figure 6-6: Export dialog box 

When the system finishes compiling, “Export finished successfully” is displayed in 
the Result pane. 

For completeness, this process may also be performed in the %SYS namespace for 
the project EDR_SYS. This is not necessary, however, because the production 
settings will not be modified in the %SYS namespace, so the export file will be 
identical to the EDE_SYS.XML file used to import the system items. 
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6.0 IHSProduction Start 

6.1 Starting the production 
Log on to the EIE Management Portal by opening Internet Explorer and navigating to 
http://(server:port)/csp/ensrpms/BADE.Zen.Home.cls 

 
Figure 8-1: EIE Management Portal logon page 

Log in as a user with sufficient privilege to access the EIE Management Portal and 
manage the production. (A super user login will have these privileges.) 

On the Production Monitor page, click Start Production to start the 
BADE.IHSProduction. 

6.2 Alternative method for starting the production 
An alternative method for starting the production is provided by the Ensemble 
Management Portal. 

In Ensemble Studio, click Ensemble Management on the File menu. 

http://(server:port)/csp/ensrpms/BADE.Zen.Home.cls�
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Figure 8-2: Ensemble Management menu option 
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Or, In the System Management Portal, click Ensemble Management Portal under 
System Administration. 

 
Figure 8-3: Starting the Ensemble Management Portal 
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The namespace should be ENSRPMS. 

• In the Namespace list, click ENSRPMS. 

 
Figure 8-4: Selecting the ENSRPMS namespace 
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If the BADE.IHSProduction is listed next to Production (just below the Start 
Production button), click Start Production. 

 
Figure 8-5: Selecting BADE.IHSProduction 
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If the production is blank, or if it is a different production, click the more link: 

 
Figure 8-6: more link 
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On the Ensemble Productions page, find the row for the BADE.IHSProduction. 

 
Figure 8-7: Configuring BADE.IHSProduction 

Click Start, then click OK in the confirmation dialog box. 
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Click OK on the Ensemble Production Start screen to return to the Ensemble 
Management Portal. 

 
Figure 8-8: Ensemble Production Start screen 
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7.0 Contact Information 
If you have any questions or comments regarding this distribution, please contact the 
OIT Help Desk (IHS). 

Phone: (505) 248-4371 or (888) 830-7280 (toll free) 

Fax: (505) 248-4363 

Web: 
Email: 

http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm 

support@ihs.gov 

 

http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm�
mailto:support@ihs.gov�
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